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Product Modelling

The IPM Product Viability Model is a ready to use business application module for the Microsoft® Excel 
spreadsheet. This versatile product is a member of IPM's Business Solution Series and is designed to 
satisfy a wide range of business planning needs. IPM have harnessed the powerful features available in 
Microsoft® Excel to give you one of the most comprehensive products available today.

Potential users who would benefit from this application include:

· Company Directors
· Marketing Managers
· Product Managers
· Development Managers
· General Managers
· Consultants

It is particularly relevant to those working in:

· Small Business Ventures
· Business Units
· Product Management
· Marketing Management
· Financial Management
· General Management
· Development Management
· Consultancy

The Product Viability Model can be used on its own or as part of an integrated suite. Information 
generated using the Product Viability Modelling application can be consolidated* with that from the 
Financial Planner* to provide a comprehensive financial overview.

* using other IPM Products.



Overview

The Product Viability Model is a ready to use business application module for the Microsoft® Excel 
spreadsheet. This versatile product is a member of IPMs Business Solution Series, it will help you to 
determine the commercial viability of a new product before committing to actual development. IPM have 
harnessed the powerful features available in Microsoft® Excel to give you one of the most comprehensive
business products available today.

Financial ratios, interactive scenario analysis and discounted cash flow projections up to 6 years can all 
be produced and analysed with ease. Management presentations can be undertaken with absolute 
confidence and what if scenarios can be dealt with in real time. 

The Product Viability Model will have immense value to anyone with a professional interest in product 
business planning. Company Directors, Marketing Managers, Product Managers, Development Managers
and Consultants will find this an invaluable business tool. The generic nature of this application makes it 
eminently suitable for a wide range of business fields.

The Product Viability Model is extremely versatile and easy to use. Colour coded templates and 
navigational maps provide the user with a modern, ergonomic interface. On line help is available 
throughout the product in the form of cell notes that can be viewed automatically in Excel 7 (when the 
mouse cursor is placed over a cell note indicator) or manually in Excel 5 (accessed from the tool bar).

Features
· Viability modelling
· Scenario analysis (what if) on 10 variables
· Direct and Indirect sales 
· Optional 3 to 6 year plans
· Discounted cash flow analysis 
· Assets and liabilities
· Interactive 
· Ratio analysis - 12 pre-set and 4 user configurable
· Graphical results set



Creating a Product Viability Model

To create your Product Viability Model you will need to enter a large amount of information. During the 
creation process, it is not necessary that you enter this data in any particular order. It is more likely that 
you will assimilate the information required over a period of time and enter it into the plan as it becomes 
available.

Before you begin, however you should decide upon the Product Name and the duration of your plan.

Once you are ready to begin, follow the steps below to create your Product Viability Model.

Start the Product Viability Model application. On the Product Viability menu bar several sub menu items 
become available.

Create a new plan by selecting New Plan on the Product Viability menu bar. You will be offered a dialog 
box which you can use to enter the following information:

Product Name

Plan Author

Plan Duration

Year end date

Start Date

Do not worry if you cannot enter all of these details at this time. You can go back and modify each of 
these items at any time during the creation of the plan by using the Details menu item.

Upon opening a new plan you will be guided to the first sheet in the Workbook. This is a navigational map
which will help guide you around the Workbook. You will be able to return to this sheet by simply clicking 
on the HOME button (a HOME button is available on the top left hand corner of each sheet in the 
workbook).

The structure of the model enables you to balance all of the costs associated with the development, 
manufacture and marketing of product against the predicted revenue. 

The Product Viability Model requires the following inputs:

Sales Volume and Unit Price

Variable Costs

Fixed Costs

Manufacturing and Development Costs

Assets and Liabilities

Having created the baseline model you can now use it to assess the overall viability of the product and to 
perform what if analysis.



Assessment and What If Analysis

Having created the baseline model you should review the overall viability by viewing the Summary and 
Graph  sheets. If you are not happy with the results of the model, you can go back and re-enter any of the
data as required.

It is likely that your organisation will have specific goals for product developments. If this is the case you 
may enter these in the Ratios sheet. By doing this, you can easily compare the ratios of your model with 
those required by the mission of the organisation.

As with any forecast, it is probable that things may not go as expected. The Product Viability Model 
provides a powerful tool to enable you to determine the sensitivity of your result to variations in forecast. 
The Sensitivity and Ratios sheet allows you to vary twelve key financial ratios and to instantly view the 
results in either graphical or tabular form.



Platform Requirements

In order that you achieve best results from the application, the MINIMUM hardware requirement is an IBM
or Compatible PC 486DX66 (Pentium recommended); 8 Mbytes of RAM, VGA or better (SVGA 
recommended).

The Product Viability Model requires that your machine is running either 
Windows 3.1 and Microsoft® Office with Excel Version 5 

or 
Windows 95 and Microsoft® Office Version 7 or Excel Version 5 or 7.



Starting the Product Viability Model 
If you are running Windows 95, the install Add In will add an Innovation Process Management folder to 
your Programs group. To create a new or open an existing Financial Plan click Start - Programs - 
Innovation Process Management - Product Viability from the Task Bar.

If you are running Windows 3.1, the install Add In will create a new Program Manager group containing 
the application icons. To create a new or open an existing Financial Plan double-click the Product Viability
icon in the Innovation Process Management program group.



Example Plan
An example file (pplanex1.xls ) is included to help you get started. This file is loaded into your IPM 
directory during the installation process.

Data included in the example file are totally fictitious and intended for example use only.

By exploring the example the principles behind the Product Viability Model can be easily seen. Settings in
the example may be modified and saved as required by the user.



Installing and De-Installing the Product Viability Model

Installation Disk Contents
The installation disk contains the following items:

1. Installation program

2. Product Viability Model program files. (Excel Add In and Excel template).

3. Help file (installation and user help)

4. Product Viability Model example plan

Installing Product Viability Model
To install the files on your hard disk, first close all applications, including Excel, and run the install Add In 
'setup.xla' from the release disk. You can do this by:

1. Opening Excel and choosing File Open a:\setup.xla

2. In Windows 3.1 from either Program Manager or File Manager choose File Run and type a:\
setup.xla in the Command Line box.

3. In Windows 95 click Start and select Run, then type a:\setup.xla in the Open box.

Note: Replace a:\ with b:\ as appropriate for your machine.

Microsoft Excel must be installed on your computer before you install the Product Viability Model.

The installation program will automatically guide you through the installation process prompting you for 
information as required.

De-Installing Product Viability Model
The Product Viability Model application comprises of a spreadsheet template and Add-In module for 
Microsoft® Excel. There are no executable programs or libraries and the installation process makes no 
changes to the Windows registration database.

All IPM Product Viability Model files are located in the directory selected during the installation process 
(by default this was C:\IPM).

To de-install the application:

1. If you have placed any of your own data files in the IPM directory, move them to another location.

2. Using either File Manager or Explorer simply delete, from the installation directory, all files with 
names beginning with the initial letter P.

3. If you do not have any other IPM applications installed, delete the installation directory using 
either File Manager or Explorer.

4. In Windows 3.1 using Program Manager, delete the Product Viability Model application icons 
from the Innovation Process Management group box. If you do not have any other IPM 
applications installed, delete the Innovation Process Management group box.

5. In Windows 95 click Start - Settings - Task Bar. On the Task Bar Properties dialog box, Click Start 
Menu Programs - Remove. In the directory list window click + next to Innovation Process 
Management then highlight and remove the Product Viability Model shortcuts.



Trial Users
Trial Users should follow the instructions regarding the program installation and when prompted for a Disk
Key should leave the box blank.

The Product Viability Model will be installed and remain fully operational for a period of 30 days.

Please note: Product plans created by the trial version can not be opened after the 30 day time 
period and any data entered can not be transferred to the full version.

For further information regarding price and availability please open the Order workbook (order.xls) located
in the IPM directory.



Product Viability Model Architecture

Each plan created by the Product Viability Model is a self contained Microsoft® Excel Workbook.

The first sheet in the book is a navigation map which provides an easy method for entering and accessing
data.

Once you have loaded a plan, you may go to a particular area of interest by simply clicking on the 
coloured boxes on the map.



Business Solution Series

IPM has created a comprehensive range of business tools. Other products in the series include:

· Financial Planner
· Bid Management
· Marketing Communications
· Visual Mapping
· Marketing Audit

For further information regarding price and availability of these modules please open the Order Form 
workbook (order.xls) located in the IPM directory.



Summaries and Graphs

The Product Viability Model provides tabular and graphical summaries to enable quick and easy 
assessment of the model.

The baseline Summary sheet shows the expected result of the venture. Two additional sheets provide 
summaries for Scenario 1 and Scenario 2. Each of these represent a possible outcome due to the 
predicted variations entered in the Sensitivity sheet.

The Graph sheet provides a Graphical representation of the overall model, including sensitivities, plotted 
for the duration of the plan. Charts are included for:

· Profit (Line Graph)
· Revenue (Line Graph)
· Cumulative Cash Flow (Line Graph)
· Cumulative Discounted Cash Flow (Line Graph)
· Cost Breakdown (Pie Chart)

A top level financial summary on the Graph sheet shows:

· Total Revenue
· Variable Costs
· Gross Profit
· Profit



Sensitivity and Ratios

Two what if scenarios may be included within the model.

Ten key parameters can be varied to determine the outcome of the plan under different conditions.

A line graph, situated adjacent to the entry fields, immediately displays the effect of the variation. The 
graph in view can be selected to display Profit, Revenue, Cash Flow, or Discounted Cash Flow) as 
required.

Twelve key financial ratios provide a performance overview of the model (baseline) together with the 
results under the conditions of the two scenarios.

· Profit (%Sales)
· Manufacturing cost (%Sales)
· Total Fixed & Variable Costs (%Sales)
· Development recovery (%Sales)
· Development Cost
· Development Cost (%Sales)
· Capital Cost
· Direct Sales (%Sales)
· Indirect Sales (%Sales)
· Marketing Communication (%Sales)
· After Sales (%Sales)
· Discounted Cash Flow Surplus after over the period

A Mission can also be entered for each of the 12 ratios to enable easy comparison of the Model against 
organisational Goals.

The 12 pre-defined ratios are complemented by four user defined ratio fields, allowing user defined ratios 
to be added if required.



Assets and Liabilities

Manufacturing Stock
The Stock Value required for the operation may be entered either as a fixed manufacturing stock value or 
as a percentage of manufacturing cost. Increases in stock will lead to a theoretical improvement in 
delivery time scales.

Creditor and Debtor Days
You may independently set both Creditor and Debtor days.

The Working Capital requirement is calculated as the sum of the working stock requirement and credit.

Development costs are added to the Working Capital requirement to provide a Total Working Capital 
requirement per year. 

Liquidity and Current Ratios provide an indication of the financial performance of the product 
investment.



Sales and Variable Costs

The Direct and OEM / Dealer Sales and Variable Costs sheets are stand alone Worksheets. The only 
information required from elsewhere in the model is the Product Manufacturing Cost. Once these sheets 
are completed, you will have a summary of the revenue, variable costs and contribution for your product.

Sales
The two separate sheets enable you to enter both Direct and OEM or Dealer Sales along with their 
associated costs. If your organisation does not have both types of income, then simply leave the 
appropriate one blank.

To enable the model to calculate Revenue you should first specify all of your Markets and Market 
Sectors; then input a forecast of the Sales Volume (or number of units) and the Unit Selling Price for 
each. 

The model enables you to enter Unit Selling Prices which vary by Market if required.

Variable Costs
The Variable Selling Costs attributable to earning the Revenue are categorised as follows:

· Distribution / selling costs
· Warranty costs
· Freight/Duty/Local costs

Each of these should be estimated and entered as a percentage of unit selling price. By this method, 
these costs will vary in proportion to the number of units sold. 

The option to enter a Variable Cost of fixed value per annum is available if required.



Fixed Costs

Two separate sheets enable you to enter the Fixed Selling Costs associated with both Direct and OEM or 
Dealer Sales. If your organisation does not have both types of cost, then simply leave the appropriate one
blank.

The Fixed Selling Costs attributable to earning the Revenue are categorised as follows:

· Marketing Communications
· Sales
· After sales
· Indirect Costs

Each of these categories are further divided into sub-categories. The sub-categories (with the exception 
of the Fixed Salary and Head Count groups) may be re-labelled if required.



Manufacturing Development and Capital Costs

Manufacturing Cost
Manufacturing Cost is the per unit cost of the product. Data should be entered in the form of a High 
Volume cost / unit, a Low Volume cost / unit and a unit price break. 

Development Costs
Development Costs are the costs associated with developing the product. These costs may be entered 
under two major headings:

· Development Costs
· Capital Costs

These categories are further divided into sub-categories which may be re-labelled if required.



Menu Command Summary

All of the functions required to generate product models and adjust their settings are accessible from the 
Microsoft® Excel menu bar.

If there are no workbooks open, the Product Viability menu will be at the bottom of the File menu, if a 
worksheet is displayed, it will be at or near the bottom of the Tools menu.

The cascaded menu on the Product Viability menu contains the following items:

New plan

Open existing plan

Consolidate

Details*

About

* The Details menu item will only become available once a workbook is open.



New Plan Command

The New Plan menu command creates a new Viability Model.
Each time you create a new plan, you will be prompted to enter the basic details of the plan. These 
include:

Product Name

Plan Author

Plan Duration

Year end date

Start Date

If you wish, you may change these entries later by clicking Details on the Product Viability menu.

Every plan you create is a self contained Excel Workbook.



Open Existing Plan Command

The Open Existing Plan menu command opens a previously created Viability Model.
You can open several plans simultaneously. One or more windows on each plan can be viewed and data 
compared or transferred as required. Use the Window menu to switch between plans.



Consolidate Command

This option is available as an upgrade. When installed it enables the information in several Viability 
Models to be consolidated into a single summary. 



Details Command

This option allows you to change the basic details of the plan. These details would normally have been 
entered at the time the plan was created. They include:

Product Name

Plan Author

Plan Duration

Year end date

Start Date



About

This command allows you to view the version and build number of the program and workbooks. It must be
quoted in the event of any technical or user queries.



The first sheet in each Product Viability Model workbook is a navigation map. This provides an easy 
method for entering and accessing data. To go to a particular area of interest, simply click on the 
appropriate coloured box on the map.



Consolidation enables several plans to be summarised into a single result. For example if an 
organisation is running many product lines concurrently, the viability models representing each of the 
product lines can be summarised to give a result for the entire department or organisation.



The Product Name should be an unambiguous product title. If you intend to consolidate plans, it is 
important that this cannot be confused with titles other individuals may be using for their models.



The Plan Author is individual responsible for compiling and maintaining the plan.



The Year End Date of each plan is normally the same as the accounting year end for the company. If you
intend to consolidate plans, it is important that the Year End Date be entered correctly.



The Start Date  is the date on which the Viability Model is planned to commence.



The Plan Duration is the number of years to be covered by the Viability Model. This can be from 3 to 6 
years. If you enter a number less than 6, you may increase this later if you wish. You cannot however 
reduce the Plan Duration to a number less than its current value.



Direct Sales are sales achieved via your own sales force direct to the end user.



OEM or Dealer Sales are sales achieved via a dealer or distribution network.




